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STORMSHED 3G            
BEGINNER TRAINING

Alex Nguyen, PE  
HQ Hydraulics Section

StormShed3G
Learning Outcomes

• WSDOT Hydraulic Design and 
Stormwater Design Processes

• What is StormShed3G? 

• Understand some basics and 
limitations behind the model

• Run StormShed3G to size 
pipe and ditch networks for 
conveyance design

• Be able to review and 
compare StormShed3G output
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8:00 – 9:00    StormShed3G  Introduction and install on computers

9:00 – 9:45  Work Session 1 - Overview and Project Configuration

9:45 – 10:00 Break 

10:00 – 11:30 Work Session 2 - Basins and Conveyance Design Storms

11:30 – 12:30 Lunch

12:30 – 2:00  Work Session 3 - Ditch Design

2:00 – 2:15    Break

2:15 – 4:30    Work Session 4 - Pipe Network Design
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StormShed3G
AGENDA
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• Hydraulic Manual and Highway 
Runoff Manual

• Pipe Networks, Ditches, Inlet 
Spacing, Culverts, Fish Passage, 
Stream Realignment

• Stormwater BMPs

• Hydraulic and stormwater training 
opportunities on LMS and HQ 
Hydraulics Webpage

General
WSDOT Hydraulic and Stormwater Design

• 2014 HRM Training (S)

• MGSFlood (S)

• Hydraulics and Hydrology (H) 

• StormShed3G Beginner (H)

• StormShed3G Intermediate (S)   
– for eastern Washington only

(S) = Stormwater Class

(H) = Hydraulics Class

General
WSDOT Hydraulic and Stormwater Design

Just been tasked with the Hydraulic Design 
for your project? 

Congratulations! 

Now what?

General
Where to Begin?
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• WSDOT Hydraulics Report Outline
http://www.wsdot.wa.gov/NR/rdonlyres/9FCA0CE5-B79C-428C-90BC-602011C70428/0/HROnline.pdf

• Hydraulics Report Checklist
http://www.wsdot.wa.gov/NR/rdonlyres/24B090A2-A8BA-40A4-856C-04F1893B26E1/0/HRChecklist.pdf

• Review Project Summary

• Talk to the local area Maintenance Superintendent

• Walk the project (with Maintenance if possible) 

• Stormwater and Hydraulics pre-design meeting

• Install piezometers as soon as possible
• Hydraulics Manual Chapter 1, Flow Chart of Hydraulic Report Review 

Schedule on Page 1-10 (next slide)

General
Where to Begin?

WSDOT HM Page 1-10 
(There’s no figure 
number for it yet!)

Scoping

• The scope was developed with input from the Region 
Hydraulic Engineer and Region Maintenance.

Project Design

• The design team may discover other hydraulic 
deficiencies as the stormwater and hydraulic design 
progresses.
• Stormwater Retrofit or Pipe Retrofits

• Illicit Discharge Detection and Elimination (IDDE)

• Existing flooding or hydraulic capacity problems identified by 
Region Maintenance

General
Identifying Hydraulic Design Issues
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• The design of conveyance systems 
statewide (pipe networks and ditches).  

• Runoff treatment and flow control BMPs 
including bioinfiltration swales, natural 
dispersion, infiltration and detention 
ponds. (EWA only).

• WSDOT has 118 shared licenses

• Graphical User Interface with Drag and 
Drop functions

StormShed3G
What is StormShed3G?

• Design Storm and Precipitation – conveyance design criteria 
in Hydraulics Manual Figure 1-4 (and for eastern WA, see the 
Highway Runoff Manual for Stormwater design requirements).

• Set up Basins– determine all areas contributing runoff to the 
conveyance system (and stormwater BMP for eastern WA)

• Set up Nodes and Reaches – Nodes are CB, MH, inlets, etc.; 
Reaches are pipes, ditches, and channels.

• Define Conveyance System – Design pipe and ditch network 
to meet design guidelines.

• Design the Stormwater BMP – for eastern WA only.

StormShed3G
How to Run StormShed3G?

Now you are ready for StormShed3G.

During design remember to:
• Coordinate with the roadway designer regarding the design or 

any project design changes that could affect hydraulic the 
design.

• Keep in-touch with Region Hydraulic Engineer.
• Contact Region Maintenance Superintendent about region 

maintenance practices.
• Ask for help! Both Region and HQ Hydraulics are available to 

provide assistance.

StormShed3G
How to Run StormShed3G?
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In this example, you will learn: 

• What the program does. 

• An introduction of the program views and menus. 

• How to customize a project file using the Project Configuration tabs. 
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What is StormShed3G? 
StormShed3G is Single Event Model with an integrated set of hydrology design tools 
developed to address the need of the Engineers.  StormSHED offers SCS (Soil 
Conservation Service), SBUH (Santa Barbara Unit Hydrograph), the Rational Method, 
level pool routing, pipe and ditch conveyance system analysis and backwater 
computation.  StormShed3G can design and analyze a whole network of reaches 
consisting of any combination of circular, arch, box, or elliptical pipe, ditches, and 
channels.  Designers have a choice between using Manning’s equation (we call it the 
travel time shift) or one of four hydrograph routing options: storage, convex, kinematics 
wave or Muskingum-Cunge routing.  Once the runoff has been conveyed to a detention 
pond, the Reservoir Routing operation would be the final step in the pond design. 
In support of reservoir routing (your typical detention pond), StormShed3G permits the 
user to select any combination of discharge structures to be used with the specified 
impoundment shape (it can be an above or below ground structure).  The list of discharge 
structures includes weirs, orifice, culverts, vortex valve, infiltration rate (including using 
Ksat), overflow, and drywells.  The user can also specify a secondary discharge control 
structure and even divert part of the flow.    
StormShed3G has options that can customize a design to make following the WSDOT 
Hydraulics Manual (HM) and Highway Runoff Manual (HRM) requirements easier.  For 
example designers can now set the duration of a design storm (EW short duration 
storms), making it simpler than the old 24 hour default when using design storms.  
Designers also have the option of selecting an antecedent moisture condition (AMC) for 
the project as well as setting constraints on the minimum time of concentration.  Multiple 
precipitation values can be input into a project file, which makes going from a short 
duration storm to a long duration storm easier.  In addition, default settings for all new 
basins for a project can be set using the PROTOTYPE basin.  Lastly, a calculator was 
added for a quick analysis on flow profiles, swales, and pipes. 
At this time, WSDOT supports StormShed3G for conveyance design only in Western 
Washington.  WSDOT utilizes all of StormShed3G capabilities in Eastern Washington. 
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Overview 
The program window is divided into two sections, each of which has several tabs. The 
major sections are the data Data Tree View and the Layout View.  When StormShed3G is 
opened, it will open to the last file used and this is what it should look like: 

 
1. Data Tree View has two tabs.  

• The Data Tree tab contains access to all of the items that the project is made up of 
including the basins, ponds, pipes, ditches, hydrographs, etc. 

• The Documentation tab provides information about particular methods used for 
the analysis.  For example if you want to see how the time of concentration is 
determined or how runoff is estimated the methods are described in this view. 

2. Layout View has 6 separate tabs, each consisting of different major functions in the 
program. 

• Pond Design is used for designing ponds.  Western Washington still uses a 
modified single event (Stormshed) method for expanding existing detention 
ponds. 

• Documentation displays the selected documentation subject chosen using the 
Documentation Tree.  
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• History View displays the computed information that affects the hydrographs from 
the pond design and layout compute command.  There is no running log of 
computations, only the last computation is maintained.  The data in the history 
view will need to be cut and pasted into a word document for the final report. 

• Hydrographs all hydrographs created by the program are reported here along with 
several options for manipulating hydrographs.  

• Plots will generate different plots depending on the input parameters. 

• Layout View is used to create a graphical representation of the drainage network.  
It is a schematic layout tool in that the dimensions of the layout (nodes and 
reaches) are not drawn to scale.  A typical layout consists of a series of nodes 
connected by reaches.  The next figure shows the Layout View. 

 
The program makes extensive use of the mouse buttons in the Layout View to facilitate 
program interaction. The following mouse button clicks are supported. 

• Left Mouse Button (LMB) click and hold while dragging mouse to reposition a 
node.   

• LMB double click on a node or reach to display appropriate input dialog. 

• Right Mouse Button (RMB) single click on a node or reach to activate a popup 
menu.  The popup menu has five choices: 
a:  Delete - Deletes the node or reach from the layout.  It does not delete the node 

or reach from the database! 
b:  Set TW Elevation (Nodes only) allows definition of starting HGL elevation.  

Typically used only for the outlet node. 
c:  Synchoronize Inverts – This command will reset the invert elevations all way 

to the final node.  This command is especially useful when an invert elevation 
is modified upstream that requires modification of downstream invert elev. 

d:  Reverse Reach Direction – when a reach is input in the wrong direction, this 
command will reverse the direction. 
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e: Set as Terminal Node – Make sure that this is the last node (outlet) of the 
conveyance system 

 
Menu Options 
Above the Data Tree View, there are 4 menu options:  File, Data, Misc, and Help.  All 
four are further discussed below. 

1. File – allows the user to open an existing file, create a new file, save a file, delete 
a existing project or exit the program. 

2. Data – The Config command is the starting place for every project and allows the 
designer to set project defaults.  The discharge, node, reach, and basin can be 

opened directly from here, as well as in 
the tree view.  The Change Basin 
option, allows the designer to change 
the rain type, hydrograph interval, storm 
duration, and design method of all the 
basins selected.  The Basin/Hydrograph 
Summary Report allows the user to send 
selected basin or hydrograph 
information to the History View.   

3. Misc – In this tab designers can access a calculator 
used to estimating flow profile, pipe, and swales.  The 
Manning pipe, is also a calculator that uses 
Manning’s equation to size a pipe.  Designers can 
input Soil Logs, open/edit text files, and several 
utilities options (SpaceToTab, TabToComma, and 
CommaToTab) that allow designers to work between 
project files.  The Edit ASCII option, allows designers 
to edit .RAC files or other program defaults. 

4. Help – Contains information about licensing, registration, and server URL.  The 
ESI Website link allows designers to access the Engenious website directly.  The 
Import Project command can be used to import and convert old StormSHED files.  
It should be noted that while StormSHED files can be transferred into 
StormShed3G, the layouts created in StormSHED can not be imported.  
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Designers need to recreate the layouts in 3G. The Revision Log will provide a list 
of any changes or updates that have been made to the program.  If the Start Up 
Message is checked, the Revision Log will appear everytime 3G is opened. 

 

Data Tree View 
The first line in the Data Tree View begins with the name of the current file (in the view 
below the project name was ‘overview project configuration’).  Within each database 
there are six (6) types of records, they are Basins, Discharge, Hydrographs, Layouts, 
Nodes and Reaches.  A + (plus) symbol to the right of each category indicates the 
presence of database records for the category. 

Categories are expanded by Left Mouse Button (LMB) 
clicking on the + (plus) symbol to the left of the category.  
Within each category there can be several record types.  
As an example, for Basins, there can be SBUH, SCS, and 
Rational basins.  The program has a different icon symbol 
for each record type within a category.  This provides a 
visual clue of the record type without directly accessing 
the record. 
With the exception of the Hydrograph category, all 
categories have at least a single prototype record when a 
new project is opened.  The PROTOTYPE record can be 
thought of as the default record.  When the program 
creates a new record for a category, it uses the 
PROTOTYPE record as its template.  This feature is 
provided to save on repetitive data input.  DO NOT 
DELETE OR RENAME THE PROTOTYPE. 
When a record is RMB clicked, it pulls up a dialog of 

some type.  Generally this allows the designer to modify the record including: open, 
rename, create, write notes, send information to the history view and delete.   
When a record is double LMB clicked, the input dialog for that record appears.  The input 
dialog is also accessible through the Data Tree View menu as discussed above. 

 
Project Configuration 
After a project is created, the next step is to set the project defaults.  In this section we 
will set the project defaults that need to be modified for our example and then review the 
remaining defaults tabs.  

1) Select Data>Config. 
The Project Configuration box will open as shown below.  The defaults set in this 
dialog box will be reflected in the pull-down menus of other dialog boxes as well 
as in the layout presentation. 



Overview and Project Configuration Work Session 1 

5/07/2016 11 Final 

 
Of the tabs in the Project Configuration dialog box, the Project Defaults tab will 
likely be used the most by designers.  This is where the precipitation values are 
set for each project location. 

2) Project Precips – After determining the precipitation values (see the short duration 
and long duration storm sections), input the values as shown.   

• To modify an existing value, highlight the design event and then input the 
precipitation.  Accept the change by selecting the update button. 

• To add a new value, input a title for the design event and precipitation, then select 
the add button. 

• Designers must have the Design Event called “2yr 24hr” and input a 2 year 
24 hour precipitation value even if the value is not needed for the design of 
the project.  It is needed for the calculation of sheet flow.  StormShed3G will 
return an error message box either if the “2yr 24hr” Design Event is missing or if 
the precipitation value is not input.  Using “0.00” is a valid input for “Precip”. 
There are no limits on the number of precipitation values that can be input.  That 
means for projects using the short and long duration storm, all the precipitation 
values can be input at one time and then selected when needed. 

3) Use AMC for Project - The AMC or antecedent moisture condition classifies 
(groups 1,2, or 3) the preexisting soil wetting at the project site.  The three groups 
are: 1) dry, cracked soils, 2) a typical condition, and 3) saturated soil.  All the CN 
values in the SCS Land Use Tab (see several boxes), are based on AMC Group 2.  
Designers should leave this as Group 2 when starting a project and always input 
the CN values for group 2.  Then after the project is completed, change to group 1 
or 3 and the program will automatically adjust the CN values in the final 
computations, the actual values input will not be modified.  There is also an 
option of temporarily modifying the AMC group value for each basin to see how 
the runoff could be affect by this change. 

4) IDF Curves in Selection Drop Down - StormShed3G supports the Rational 
Method and allows the designer two options for referencing IDF curves; either by 
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equation using a table of data (like the data found in Chapter 2 of the Hydraulics 
Manual) or referencing an IDF curve.  In this box the designer can indicate how 
many options there will be in the Basins Dialog input box if the Rational Method 
as a Design Methods from the pull-down menu.  For this training we will not be 
using the Rational Method, so we will leave it on the default setting of ‘Both’. 

5) TC Thresholds – Chapter 2 of the Hydraulics Manual requires a minimum Time 
of Concentration of 5 minutes.  In order to ensure this value is 5 minutes, 
designers have the option of setting minimum Tc values for both the SCS (also 
applies to SBUH) impervious and pervious conditions as well as for the Rational 
Method.  For this training we will leave the values set at 5 the default values of 
minutes. 
 

6) Next select the Default Labels tab.  This is where the designer can customize the 
labels for new reaches, nodes, discharge, and basins.  While it is often convenient 
to use the auto labels, be sure to check the “Enable Auto-Verification of Labels” 
box.  This will allow the designer to override the StormShed3G auto labels and 
instead create a label that is more meaningful to the project.  
Set the defaults to the picture shown below. 

 
 

7) The Application Links tabs, indicates where the RAC Files/IDF Files and 
Training Videos are located on our computer.  Do not save either in the same 
folder as the program or project files, as they could be deleted when the software 
is upgraded.  Instead save them in a completely different folder and path the 



Overview and Project Configuration Work Session 1 

5/07/2016 13 Final 

location by selecting the ‘…’ button to the left of the clear button. 

 
8) Conduit Adjustment1 – This option only applies to Detention Ponds that use 

conduit as a discharge structure; 3G requires that the length be increased 
automatically.  Designers have the option of adjusting the conduit length.  
Remember the smaller the value, the longer it will take StormShed to perform this 
computation.  

 
9) The Conduit Sizes1, Arch Sizes1, and Elipse Sizes1 tabs are used to modify or add 

the default pipe sizes (the Conduit Sizes tab is shown above).  These sizes and 
dimensions can be found in the Reach Dialog box pull-down menus to set pipe 
sizes.  Note the SI Units tab is only there to modify a design that is already been 
created in US units and then change to SI and the report will be printed in metric. 

10) The SCS Land Use1 tab contains the CN values for the group 2 AMC.  Designers 
can modify or add CN values in this tab.  Notice the CN values are separated by 
land use; they will be accessed under these categories in the Basin pull down 
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menus. 

 
 

11) The Ground Cover Coefficients1 tab, contains the default values for the type of 
flow (sheet, shallow, concentrated, etc) found in the Basin Dialog Box pulldown 
TC menus.  Unique values can be modified or added here. 

 
 

12) The Rational Land Use1 tab, contains the coefficients for ground cover that are 
applied when calculating the Time of Concentration using the Rational Method.  
These values match the values found in section 2-5 of the Hydraulics Manual 2-5.  
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This tab can be used to modify or add values that will better represent a project 
location. 

 
 

13) The Mannings ‘n’1 and Conduit Coef1 tabs contains Manning’s values directly 
from Appendix 4 of the Hydraulics Manual.  These values can be selected from 
the pull down menu in the Reach Dialog Box.  Use this tab to modify or add 
values that will more accurately reflect a project site. 
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14) The Culver Constants1 tab contains the Coefficient information used in the 
Reach Dialog Box pulldown menus for entrance losses.  These values are based 
on the FHWA guidelines and can not be modified although new values can be 
added.  

 
15) Finally, the only tab we have not reviewed is the Layout Colors tab.  Here the 

settings for the layout can be customized from the colors, the fill, to the line type.  
It is recommended that the values selected are easy for the designer and reviewer 
to see and use.  At this time, this feature has been disabled. 
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In this example you will learn: 

• How to determine the applicable storm duration for a project location.  

• How to Create a basin, know the different basin options, and how to estimate 
runoff from a basin. 

• How to transfer basin information to a report. 

• The Slope Calculator. 
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Example Problem 
Develop basins for the before and after conditions using the following description:   

• A new two-lane roadway section is to be constructed near Seattle, which is in 
Climatic Region 3.   

• The SCS soil type for the entire project is Type C and the ground cover is 
primarily forest in fair conditions. 

• The project area in the existing site condition currently sags to the middle of its 
1800 foot length.  The project area is also about 50 feet wide.  The ground slopes 
towards point A.  Water generally collects at point A and then runs down to point 
B in a semi-defined ditch.  The ground cover is all forested.  See Figure 1.    

• The calculated time of concentration should be assumed for the forested 
conditions to be 50 feet of sheet flow with the remaining 900 feet as shallow 
concentrated flow to point A.  Finally, runoff concentrates and flows to 50 feet to 
point B. The average slope of the ground before the construction was 1%.   

• The proposed conditions for the new impervious roadway will be slightly elevated 
and will utilize curb and gutter to control the flow.  The developed site will have a 
sag in the profile. See Figures 2 - 4 below.  

 
 
 
 

PLAN VIEW - EXISTING CONDITION 
Figure 1 
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PLAN VIEW – DEVELOPED CONDTIONS 

Figure 2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CROSS SECTION A-A 
Figure 3 

 
 
 
 

 
 

PROFILE 
Figure 4 
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Creating a New File 
When StormShed 3G is opened, it will automatically open to the last file used.  The first 
step for this example is to create a new file.   

1) Select File>New and input a unique name that will easily remind you of the 
project.  For this example, call the New Project Name: basin.  Then click on Ok. 

  
The 3G project disclaimer dialog will appear as shown below.  This is just a 
reminder that this is technical software and while the software developer has 
made every effort to eliminate errors in the program, it is up to the designer to use 
engineering judgment when reviewing the results. 

 
2) Select I Fully Understand and the box will close. 

Set Project Defaults 
After a project is created, the next step is to set the project defaults.  In this tutorial we 
will only modify the items in the Project Defaults tab. 

3) Select Data>Config. 
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The Project Configuration box will open as shown below. 

 
To eliminate the Warning dialog box; the Design Event must be typed as “2yr 24hr”.  If 
‘2 year’ is typed, the warning will continue to appear.   

4) WWA – Storm Duration 
Western Washington utilizes the Type 1A 24 hour storm to design conveyance 
systems.  The precipitation values are much simpler to determine than for EWA, 
as noted below. 

A. From the HQ Hydraulics web page, select Links.  
(http://www.wsdot.wa.gov/Design/Hydraulics) 

B. Select the Washington 24-hour Isopluvial Maps link and a set of maps for 
Washington will open including the one shown below.  

C. Locate the project on the map and determine the precipitation values for 
the 6 month, 2, 10, 25, and 100-year storms.  

D. Input these values into the Project Precipitation table (as shown in the 
picture above).   

 

http://www.wsdot.wa.gov/Design/Hydraulics
http://www.wsdot.wa.gov/publications/fulltext/Hydraulics/Wa24hrIspoluvials.pdf
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Project Precips – After determining the precipitation values (see the applicable EWA or 
WWA storm determination sections of this tutorial), input the values as shown above.   

• To modify an existing value, highlight the Design Event by LMB click on an item 
and then modify the values in the boxes above.  Accept the change by selecting 
the Update button. 

• To add a new value, input the design event and precipitation into the blank boxes, 
then select the Add button.   

For this tutorial we will leave the default selections for AMC, IDF and Tc as shown 
above. 
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 Create Basins 
First, define the ‘before’ drainage basin conditions.  

 
5) Expand the Basin option in the Data Tree View and then double click on 

PROTOTYPE to open the basin dialog box.  The PROTOTYPE dialog box is the 
template for all other basin records.  It will save time if repetitive options are set in 
the PROTOTYPE dialog box and saved before creating a new basin or use an existing 
basin to create a new basin.  Select the New button and input the basin name, for this 
tutorial use “BEFORE”.  Then click OK to close the dialog box. 

 
 

Next, we will review the input boxes on the first tab, labeled the basin name ‘before’: 

• Rainfall Type – This is where the design storm, as specified in Chapter 4 of the 
HRM, is selected.  For this project, we were told to use the Type1A.RAC for 
WWA. 

• Storm Duration – the length of a storm is set here and the program will either 
stretch or shrink a storm distribution to this time line.  For this example, set the 
duration to 24 hours in WWA.  
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• Design Method – designers have three methods to select from for the design 
analysis: SCS, SBUH, or the Rational Method.  Either the SCS or SBUH is 
acceptable on WSDOT projects, as both will yield similar results for most 
WSDOT project.  For projects with more pervious surface or in a rural area, 
consider the SCS method and for projects with more impervious surface or in an 
urban area consider the SBUH method.   

• Hyd Interval – or the hydrograph interval.  This is the interval at which data is 
reported from the 3G analysis; this value does not affect the actual analysis.  
When the Type 1A or Long Duration Storm is used, the 10-minute default is 
appropriate.   

• Peak Factor – This feature is not modified for WSDOT projects from the default 
value of 484.  This is a customization feature that will either flatten or heighten 
the hydrograph. 

• Unit Hydrograph – A unit hydrograph basically put represents the affect rainfall 
has on a particular basin.  In 3G there are two options: SCS and Delmarva.  The 
Delmarva only applies to projects in Maryland, so for all WSDOT projects the 
SCS Unit Hydrograph option should be selected. 

• Loss Method – there are three options for determining precipitation losses on a 
project: SCS, Green Ampt, and Holtan.  Generally, all WSDOT projects use the 
SCS Curve Number method, which combines infiltration losses with the initial 
abstraction.  The Green Ampt and Holtan method require more information than 
we usually have on a WSDOT project. 

6) The Perv CN tab is where the pervious drainage basin area is defined by both the 
total area in acres and the Curve Number (CN).  The CN values can be selected 
from the pull-down tab based on the land use selected, (Urban, Developing 
Urban, Cultivated Agriculture, Other Agriculture, and Arid Rangeland) and the 
HSG (Hydrologic Soils Group).  Designers should verify these values are the 
same as found in Appendix 4B of the HRM, an example is shown on the next 
page.  Note there are separate CN tables for eastern and western Washington in 
the HRM; be sure to use the correct table. 
Notice there are values already set up in the PROTOTYPE basin; these are 
examples of how to input data and should be deleted.  Next input the information 
from the example by typing the values in the boxes as shown below and then 
selecting the Add tab.  To modify information already input, LMB click on the 
data and the information will appear in the upper boxes.  Make the necessary 
changes and then select the Update button.  The changes should appear in the 
lower box. 

• For this example, input the data as shown in the box below. 
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• Move to DCIA – This option allows designers to move pervious basins to the 

impervious basin tab, a time saver when basins are accidentally input on the 
wrong tab.  Simply highlight the row, select this button, and the basin description, 
subarea, and CN will be moved to the Directly Connected CN tab.  

• Abstraction Coeff – This value can only be modified when using the SCS CN for 
the loss method.  Precipitation has to be greater than 0.2S (the maximum soil 
water retention parameter) before runoff is generated.  While this number can be 
modified in the Pervious CN tabs only, it should be left as 0.2 for WSDOT 
applications. 

• Total Area – The total pervious area entered for this basin is summed in this box. 

• Avg CN – This is the average CN computed based on all the pervious surfaces 
reported. 

Get CN values in Appendix 4B of the Highway Runoff Manual. 

http://www.wsdot.wa.gov/Environment/WaterQuality/Runoff/HighwayRunoffMa
nual.htm 

OR 

Get CN values using drop down boxes and menus. 

 

http://www.wsdot.wa.gov/Environment/WaterQuality/Runoff/HighwayRunoffManual.htm
http://www.wsdot.wa.gov/Environment/WaterQuality/Runoff/HighwayRunoffManual.htm
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7) Defining the Time of Concentration (TC) is the next step for the pervious surface.  

Select the Perv TC tab and modify the information as shown on the below using 
the example problem statement summarized below.   

• The default values in the description area are for example and need to be either 
deleted or updated. 

• For this example we have 50ft of sheet flow on a 1% and the land cover type is a 
fair forest condition.  The best match for a sheet flow Kf from the pull down 
menu is, wood or forest with dense under brush. 

• The second type of pervious flow is shallow for a length of 900ft at a 1% slope. 
Select forest with heavy ground litter and meadows for the ns value. 

• The third type of pervious flow is intermittent channel flow for a length of 50ft at 
1% (assumed).    Select forested swale with heavy ground litter for the Kc 
value. 
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Now let’s review the options in the Flow Type pull-down menu.  While there are many 
options, we generally only use the ones noted below on WSDOT projects: 

• Fixed – Rather than having the program calculate the travel time, the designer can 
manually input the value. 

• Sheet Flow – Flow, over a relatively flat surface that does not concentrate more 
than 0.1’ deep, and is less than 100’ in length is considered sheet flow.  This type 
of flow will be used to model runoff as it travels off the roadway to the shoulder. 

• Shallow Flow – Once flow exceeds the depth and or length requirements for 
Sheet Flow, it begins to have a defined flow path and is assumed to be Shallow 
Flow.  Runoff traveling along the curb line or in ditches should be modeled as 
Shallow Flow. 

• Channel Flow – Is assumed to begin where surveyed cross section information 
has been obtained, where channels are visible on aerial photographs, or where 
lines indicating streams are shown on US Geological Survey Maps.  There are 
two options for Channel Flow in 3G: intermittent and continuous.  The 
difference between the two is intermittent flow has a lower Hydraulics Radius 
(0.2) than continuous flow (0.4). 

Since in the before condition there is no impervious surface, the next two Directly 
Connected tabs should be left blank. 
 

8) The last tab, Compute Design Event, can be used to quickly compute a flow rate 
and volume of the runoff based on this basins characteristic. 

• The Select Design Event pull-down menu references the precipitation values input 
into the Program Defaults tabs.  For this example, select 25 year.   

• The AMC group can be changed for just this computation when using the 
compute command; it is not a permanent change.  This will only give the designer 
an idea of how a different AMC could affect runoff from this basin.  Note the 
Project AMC that was set in the Project Defaults tab, is also noted here. 
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• Select the Compute button for a quick look at the runoff generated from the 
basin.  Using this command does not report the data to the history view; 
instructions for reporting this data are described at the end of this tutorial.   

• Save the file before continuing! 

 
 

9) Next, the After drainage basin site conditions will be defined (the new 
impervious roadway with curb and gutters).    

• Click on the New button, to create a new basin and then type “AFTER”.  To save 
time reselecting the settings, select the “BEFORE” basin instead of the prototype 
basin. 

10) Next, delete any entries in the Perv tabs since in the after condition; the pervious 
surfaces are replaced with pavement.  Or to save time, highlight the pervious 
basin and hit the Move DCIA button.  This will automatically move the basin to 
the Directly Connected CN tab.  Remember to update the Description and CN to 
reflect an impervious area. 

 
 

11) Directly Connected CN and TC – This is the location to input impervious areas.  
The name simply describes what is happening, that is runoff from impervious 
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areas is directly connected to runoff from pervious areas within that basin.  When 
pervious runoff and impervious runoff are input into separate tabs, the program 
generates two separate hydrographs (one for the Directly Connected and one for 
the Pervious areas) and then the two hydrographs are added together.  If a 
composite CN is more representative of a project site runoff, this can still be done 
by entering both the pervious and impervious areas into the Perv CN and TC tabs.  
Then StormSHED will generate one hydrograph based on the composite CN.  
Generally two separate hydrographs summed as one, will provide a more accurate 
representation of a project site runoff.  Consider a project with 9 acres of pervious 
runoff directly connected to 1 acre of impervious runoff.  The runoff from the 1 
acre of impervious area is going to have a faster travel time than the pervious 
area.     

 
 
Next, select the Directly Connected TC tab.  Each flow path must be defined for the 
impervious area, below is a summary of the example description.  

• For this example we were told there is 5ft of sheet flow at a 1% and the land 
cover type is a paved condition.  Thus when defining the coefficient for sheet 
flow, select smooth surfaces from the pull down menu.   

• For this example we were told there is 45ft of sheet flow at a 2% and the land 
cover type is a paved condition.  Thus when defining the coefficient for sheet 
flow, select smooth surfaces from the pull down menu.   

• The second type of flow we have on the site is shallow for a length of 900ft at a 
1% slope.  From the pull down menu select paved and gravel areas as the 
coefficient value.   
Need to calculate the slope? Select the Slope Calc button below the Coeff. box 
and the calculator to the left will open.  Next input the runoff length and the up 
and down elevations and select the Compute button.  3G will automatically 
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transfer the resulting slope to the slope box for the tab that is open in the basin 
dialog box. 

 
 

12) Select the last tab, Compute, to quickly compute a flow rate and volume based on 
the after construction basin runoff as shown below.  

 
 

13) Create a Report 
Once information for each basin is entered, the designer will need to provide this 
data in the hydraulic report.  There is no formal report writing command in 3G, 
however information can be sent to the History View and then copied into a word 
document.  This can be done by: 

• LMB click to select the basin in the Data Tree View. 

• RMB click to open the menu. 

• Then LMB click to select the ‘To History’ option. 
This process should be repeated for each basin. 
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The History View will open and should look as shown below.  Notice there is information 
on each precipitation value that was entered in the Project Configuration tab as well as 
all the information input into each basin. 
Repeat the process for the ‘after’ basin.  Each item (basin, reach, node, etc) will need to 
be selected individually as described above and copied from the History View into a word 
document.  For larger projects, there is a quicker method that will be reviewed in the 
Layout Tutorial. 
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In this tutorial, you will learn about: 

• The design criteria for ditches. 

• How to model a conveyance ditch. 

• An introduction to reaches and nodes. 

• How to include infiltration in the ditch design. 

• How to use the calculator to estimate a ditch size. 
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Ditch Example 
You have been asked to determine if the ‘V’ bottom ditch running parallel to the road is adequate to 
convey the runoff from both the road and back slopes.  Figure 4-1 and 4-2 shows the plan and cross 
section view of the example project and details are noted below: 

• The pervious area from the back slopes contributing to and including the ditch is 1.0 acre.   

• The SCS soil type is Type C and the ground cover is primarily forest in fair conditions.   

• The average slope of the ground is 1%.   

• The calculated time of concentration for the forested condition will be 50 ft of sheet flow and 
900 ft of shallow concentrated flow to the beginning of the ditch.   

• The 20’ x 900’ (0.413ac) roadway, without curbing, contributes to the ditch with a cross 
slope of 2%.  

• The ditch is 900’ long and has a longitudinal slope of 1%, with a ground cover as nearly 
bare ground, very little grass.  The side slopes are 3:1. 

 
 
 
 
 
 
   
 
 
 

Figure 4-1. Plan View  
 

 
Figure 4-2 Cross Section 
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Design Criteria 
Roadside ditches are generally located alongside uncurbed roadways with the primary purpose of 
conveying runoff away from the roadway.  This is different than a bioinfiltration swale or 
biofiltration swale (or bioswale), in that a ditch only conveys drainage runoff where as a bioswale 
both conveys runoff and provides runoff treatment by filtering the runoff through vegetation.  The 
shape of a bioswale is a trapezoid.  The shape of a roadside ditch is typically a “V” ditch. 
The design criteria for ditches are in located in Section 4-3 of the Hydraulics Manual.  In short the 
following is required: 

• The design storm is the 10 year recurrence interval.  

• The maximum depth of water in the ditch is 0.5’ below the bottom of sub-grade. 

• Velocities in the ditch should not exceed 5 ft/sec and the ditch slope should be less than 6%. 

Creating a New File 
1) Select File>New and input: ditch.  Then click on Ok. 

  
The 3G project disclaimer dialog will appear as shown below.  Select I Fully Understand 
and the box will close. 

 
2) Set Project Defaults 

Select Data>Config. 
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The Project Configuration box will open as shown below. 

 
 

3) Create Basin 
1) Create a new basin named ‘Ditch’. 

 
 
4) Then define the pervious area site conditions in the Perv CN tab using the ditch example 

description on the previous page and input the values shown below.   
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5) Next, select the Perv TC tab and define the pervious surface side slope area. 

 
6) Define the impervious basin area (roadway draining toward the ditch) in the Directly 

Connected CN tab. 

 
7) Finally, define the flow path from the roadway, into the ditch in the Directly Connected TC. 
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8) Finally, estimate the flow rate of the runoff by using Compute button. 

• Select 10 year from the pull down menu. 

• LMB click on the Compute button and the results should match as shown below. 

• To save and close the basin dialog box, select the Close button. 

 
9) Create a Reach 

Next, we need to create a Reach that will represent the ditch. 

• In the Data Tree View, click on the “+” symbol next to the Reaches node. 

• Double click on “PROTOTYPE” under the Reaches node.  

• Click on the New button in the Reach Definition dialog.  

• Override the default label with D-001 and Click OK. 
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10) After the reach has been named, the next step is to define the “Section Shape” or the type of 

reach.  For this application, select Ditch. 
11) Change the “Routing Method” to TT Shift.  

The ‘Routing Method’ box contains 4 hydrologic routing methods and the Travel Time 
Shift.  The hydrologic methods actually route the hydrograph through the reach taking 
advantage of the storage that is available in the reach.  The TT shift uses the Manning’s 
equation to compute the hydraulic parameters based on the peak flow rate and assumes a 
constant depth.  Of the 5 options presented, the Muskingum-Cunge and TT shift are used the 
most.  For most applications the TT shift should be used, however there are applications 
where this method is conservative.  For long reaches with flat slopes, the Muskingum-
Cunge method provides a more representative analysis because it allows the flow to spread 
out producing a lower peak. 

 
12) In the “Uniform Flow Method” box, there are only two available options available for ditches 

(or cross sections).  Select the Manning’s equation, this is the one most commonly used in 
the United States.  The Manning’s value can either be input manually, or selected from a 
table by clicking on the ‘…’ box to the right as shown below.  All the values provided in the 
table are the average values from the Hydraulics Manual Appendix 4-1, Manning’s 
Roughness Coefficients.  
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Using the pull-down menu, select ‘Open 
channels, Excavated (Straight Alignment, 
Natural Lining)’. From that table, the 
closest match is No vegetation under the 
category ‘Earth, fairly uniform section’.  
LMB click on No vegetation and the 
Manning Lookup Form will close and the 
Manning’s value of 0.0235 will 
automatically be input into the Manning’s 
‘n’ input box. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
The following bullets apply to the lower options on the reach dialog box. 

• Notice the “Node Data” boxes are blank.  They remain blank until the up and down reaches 
are either defined in the layout view or manually attached. 

• The “Contrib Discharge” option only applies when the reach is immediately down stream of 
a detention system.  Using the pull down menu, the discharge structure that is coming 
through the reach can be identified. 

• Only check the “Save Route Hyd” box, if you would like to see a hydrograph created from 
runoff going through this reach. 
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13) Next, select the Geometry tab.  Notice the “Size” and “Entrance Losses” option are not 
available; these options only apply to pipes. 
 

Input the Ditch “Specific Geometry” values as shown below. 

 
14) The Constraints tab applies mostly to pipes and will be discussed further in the Network 

Tutorial.  The only option that applies to ditches is infiltration/exfiltration, which represents 
flow into and out of the reach.  In this case, infiltration is when water is entering a reach 
(high water table and a perforated pipe) and it is represented by a positive value.  Exfiltration 
is water exiting or leaving a reach (due to a ditch that infiltrates runoff into the soil or a reach 
with joints not properly sealed) and is represented by a negative value.  Right now leave this 
value at 0, we will repeat the example using this option. 

 
Click on the Close button to close the dialog box.  
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15) Create Nodes 
A node is required for every transition in a reach, even if there is no structure present.  In this 
tutorial, a Dummy Node must be defined to represent the ends of the reach so StormSHED 
3G can perform the calculations. 

• Open the “PROTOTYPE” node in the Nodes section of the Data Tree View.  

• Click on the New Node button.  

• Rename the default node ID to UpstreamDummy.  

 
• For the “Description” type ‘upstream point of ditch’.  For larger projects it maybe 

beneficial to provide more information in the description so when the report is read it is easy 
to determine the use of the node. 

• The “Node Type” box is where the application of the node is defined.  For the “Node Type”, 
select Dummy Node.  Once the Dummy Node radio button is selected, notice the third tab 
disappears as there is no structure to define. 

• The “Start EL’ refers to the outlet elevation or in this case the bottom of the ditch elevation 
or 224.  The “Max EL” is the top of the bank for a ditch or the rim elevation of the catch 
basin or manhole.  In the case of trap pond or vault this would be the ground elevation.  For 
this example input the “Max EL” 225. 

• The “Contributing Area” is the name of the basin that is attached to this node.  Once it is 
selected from the Contributing Drainage Areas tab, it will be shown in gray on this tab.   

• The “Contrib Hyd” pull down menu allows the designer to create a Hydrograph and apply 
that Hydrograph to the node.  For this example, leave it blank. 

• Generally the “North” and “East” boxes are left at zero, inputting a value here only affects 
the location of the node in the layout view.  If no value is entered, StormShed 3G will use the 
approximate location in the layout view when computing. 

• The “Increment for rating curve” option, only applies to the number of points plotted on the 
rating curve.  For computing, the program will use as many points as needed to run the 
analysis. 
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• All nodes support a “void ratio” for the inside of the node.  Generally this is left as 100% 
voids.  This could be helpful if the structure is filled with rock for example, the program will 
compute the correct volume of available in the structure based on the void ratio. 

16) Select the Contributing Drainage Area tab and choose the basin that is contributing runoff to 
the node, in this case use the area we just created, ditch. 

 
Click on the OK button to close the dialog box.  

17) Next create the downstream node.   

• Re-open the node named UpstreamDummy instead of the PROTOYPE node and select the 
New Node button.  Name the node DownstreamDummy and hit OK. By doing this all the 
values entered in the original node (except the name) are carried over into the new node 
(including the contributing drainage area).   

• Change the “Start” and “Max El” as shown below. 

 
18) The select the Contributing Drainage Area tab and unselect the basin called “ditch”. 

Finally close the dialog box. 
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19) Create a New Layout. 
Next create a layout to represent the ditch. 

• In the Layout View, click on the Layout View Tab and select the ‘Insert Nodes and Reaches’ 
button in the upper left corner.  

 
• Before any nodes or reaches can be placed, the program will prompt you to name the layout.  

Since some projects can have multiple layouts, it is recommended that the name of the layout 
be meaningful to the area being designed.  For this example use ‘ditch’.   

b 

• Select OK after inputting the layout name. 
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20) Next select the approximate locations of the up and down nodes as shown below.  Click the 
“Insert Nodes and Reaches” blue button at the top left corner of the layout screen.  Since the 
nodes and reaches have not been defined, the names default to the PROTOTYPE record. 
Click the “Insert Nodes and Reaches” button again to turn it off. 

 
21) Next we will define the nodes and reaches.  Double LMB click on the upper node.  Use the 

pull down menu to select UpstreamDummy for the Node ID. 

 
22) Repeat this process to define the reach and down stream node.  When finished the layout 

should appear as shown in the next view.   

 
• Save the file.  If the names are not shown, use the ‘Toggle Node Label’ and ‘Toggle Reach 

Label’ buttons until the node and reach name are shown. 
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23) To route the design storm through layout, select the compute layout button. 

 
 

• In the “through” box, use the pull down menu to select the name of the layout to run the 
design storm through.  In this case select ditch. 

• Use the pull down menu to define the Design Event as the 10 year and Rainfall Type as the 
Type IA for WWA.  For the Storm Duration; input 24 hrs for WWA.  Note that while these 
options were set when defining the basin, the values entered in the compute command 
override those settings. 

• “Use Actual Coordinates’ – this would only apply if the “North” and “East” values were 
input when the nodes were created.  For WSDOT projects this option is generally not used. 

• “Route as Rational Network” – selecting this option would allow the designer to use the 
Rational Method to analyze the layout.  Again this would override whatever design event and 
rainfall type was input into each basin, for just the compute command (the actual values input 
in the basin do not change).  Notice when this option is selected the pull-down menu choices 
change for the Design Event and the Rainfall Type. 

• “Automatic HGL” – if this option is selected the HGL analysis will be sent to the History 
View along with the Conduit Notes.  If this box is not marked, only the Gravity Analysis will 
be sent to the History View.  For this example check this box. 

• “Include IE Report” – when this box is selected, a report will be included in the history view 
of the invert elevations for the reaches and nodes.  This option allows the designer to verify 
the location of the inverts.   For this example check this box. 

• Finally, select the Route button to route the design storm through the layout and then select 
the close button to Close the dialog box. 
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24) Select the History View tab to see the routed information, as shown below. 

Appended on: Sunday, May 7, 2017 3:28:33 PM 
ROUTEHYD [] THRU [Ditch] USING [10 year] AND 
[TYPE1A.RAC] NOTZERO RELATIVE SCS/SBUH 
Gravity Analysis using 24 hr duration storm 

Reach 
ID 

Area 
(ac) 

Flow 
(cfs) 

Full Q 
(cfs) 

Full 
ratio 

nDepth 
(ft) 

Depth 
ratio Size nVel 

(ft/s) 
fVel 
(ft/s) 

Infil 
Vol 
(cf) 

CBasin / 
Hyd 

D-001 1.413 0.305 ---- 0.00 0.2559 ---- Ditch 1.5529 ----- 0.00 DITCH 
HGL Analysis 

From Node To Node HG El 
(ft) 

App 
(ft) 

Bend 
(ft) 

Junct 
Loss (ft) 

Adjusted 
HG El (ft) 

Max El 
(ft) 

 215.2559 
UpstreamDummy DownstreamDummy 224.2344 --na-- --na-- --na-- 224.2344 225.0000 
Conduit Notes 

Reach HW Depth 
(ft) 

HW/D 
ratio 

Q 
(cfs) 

TW Depth 
(ft) Dc (ft) Dn 

(ft) Comment 

D-001 0.2344 na 0.305 0.2559 0.2344 0.2559 Direct Step Backwater 
Calc 

Node and Reach invert report 
Node and Reach invert report 

Node UpstreamDummy  Out ie 224.00 ft 
 Reach D-001 I.E. Out 224.00 ft 

 
 

Licensed to: WSDOT 
 
 
Flow rate = 0.305 cfs 
Ditch velocity = 1.6 ft/second. 
Depth of flow in the ditch = 0.26 ft 
 
Ditch Design Complete. 
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Exfiltration (Create Reach D-002) 
Now we will apply Exfiltration to the reach to see how it affects flow in the ditch. 

1) Using the same file, in the Layout View, double LMB on the “ditch” reach and select the 
Constraints tab. 

2) Type ‘-2’ into the Exfiltration/Infiltration box.  This represents water leaving the reach at 
a rate of 2 in/hr. 

 
• Close the Reach dialog box. 
3) Select the Compute button and route the 10 year storm through the layout. 
4) Close the Compute Layout Form dialog box and select the History View tab. 

Note the Flow has decreased in the reach from 0.305 to 0.238 cfs.  Using the Exfiltration/Infiltration 
option will decrease the flow rate Q and Volume, which would decrease the size of a detention 
facility down stream. 

Appended on: Sunday, May 7, 2017 3:38:33 PM 
ROUTEHYD [] THRU [Ditch] USING [10 year] AND 
[TYPE1A.RAC] NOTZERO RELATIVE SCS/SBUH 
Gravity Analysis using 24 hr duration storm 

Reach 
ID 

Area 
(ac) 

Flow 
(cfs) 

Full 
Q 

(cfs) 

Full 
ratio 

nDepth 
(ft) 

Depth 
ratio Size nVel 

(ft/s) 
fVel 
(ft/s) 

Infil Vol 
(cf) 

CBasin / 
Hyd 

D-002 1.413 0.2376 ---- 0.00 0.2329 ---- Ditch 1.4597 ----- 3454.05 DITCH 
HGL Analysis 

From Node To Node HG El 
(ft) 

App 
(ft) 

Bend 
(ft) 

Junct 
Loss (ft) 

Adjusted 
HG El (ft) 

Max El 
(ft) 

 215.2329 
UpstreamDummy DownstreamDummy 224.2031 --na-- --na-- --na-- 224.2031 225.0000 
Conduit Notes 

Reach HW Depth 
(ft) 

HW/D 
ratio 

Q 
(cfs) 

TW Depth 
(ft) Dc (ft) Dn 

(ft) Comment 
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D-002 0.2031 na 0.2376 0.2329 0.2031 0.2329 Direct Step Backwater 
Calc 

Node and Reach invert report 
Node and Reach invert report 

Node UpstreamDummy  Out ie 224.00 ft 
 Reach D-002 I.E. Out 224.00 ft 

 
 

Licensed to: WSDOT 
 
=============================================================== 
Creating a Report 
There is no report command in StormSHED 3G, instead data must be copied from the History View 
and pasted into a word document.  The information in the history view is not cumulative, so it is 
important to copy the data before sending anything else to the history view. 
To copy the basin/node/reach information into a report go to the Data Tree View and RMB click on 
the layout name, then LMB click and select To History.  Select the History View tab, highlight the 
data, and copy the data by selecting Ctrl C.  Use Ctrl V to paste into a word document. 

 
 

 
Move Hydrograph Option 
The Compute option also allows a hydrograph to be routed through a reach.  We are going to use 
the Move Hydrograph option to generate a hydrograph from the basin we created.  The Move 
Hydrograph option allows as many basins as desired to be moved into one hydrograph based on a 
specified design event.  The benefit of this option is it allows the designer to manipulate the final 
hydrograph before routing it through the layout. 
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1) Select the Hydrograph tab and then select the Move tab. 
2) The previously defined basins are shown in the top box, select the basin(s) to be moved.  For 

this example select ditch.   
3) Next select a Design Event of 10 year and then hit the Move button.  After the Move button 

has been pressed, a new hydrograph will be created. The summary data is visible in the lower 
portion of the Hydrograph tab as shown above.   

4) To view the Hydrograph, select the Plots tab. 
5) Select the ditch 10 year hydrograph as shown below. 
6) For the “Type of Plot”, select the Hydrograph radio button. 

The “Hydrograph/Basin List” instructs the program to list just the hydrographs, just the 
basins, or both in the box to the left.  For this example, select the List Both radio button. 
The “Design Event” pull-down menu allows the designer to select which design event is run 
through a basin to generate a hydrograph.  This option only applies to basins.  Since we have 
already assigned a design event to our hydrograph, changing the event will not change our 
plot. 
If the “Plot as points” button were selected, the plot would appear as a series of points 
instead of line.  For this example, leave the box blank. 
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Next select the Plot tab. 

 
The Hydrograph above should appear. 
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Calculators 
Another tool available in StormSHED 3G is the calculator, which can be used to estimate the size of 
the ditch.  From the main menu select:  

Misc>Calculators. 
1) From the “Select Reach” pull-down menu, select the reach that was created in this example 

D-001.  Notice all the values input into the reach dialog box are carried over to the white 
boxes in the calculator.   

2) Modify the “Flow” to match the flow rate in the history file and the gray values on the right 
should match the history file output. 

3) Try modifying other parameters to see how the key design criteria limits are affected 
(velocity, depth, and grade). 
In this example, we increased the width of the original ditch bottom of D-001 from 0 ft to 2.0 
feet.  The velocity increased from 1.55 ft/sec to 1.28 ft/sec. 

NOTE:  Changing parameters in these calculators may change you actual design inputs 
so please be careful and save your work before using these.  I recommend creating 
different versions of your files as you change different design lengths, widths, flows, etc. 
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In this tutorial, you will learn about: 

• Define Nodes and Reaches. 

• How to create layouts. 

• How to use the compute command in the layout view. 

• How to generate a report for all the elements in the layout view and the output. 
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Example 
Create a storm drain network in the layout view and design the pipes using the 25-year MRI.  
Determine pipe sizes required given the following information.  

• The section of roadway is in a sag condition, with CB3 and CB4 located at the low point.   

• The curve crest is 600 feet north of CB1/2 and South of CB5/6, see Figure 1. 

• Assume catch basins type 1 and that each is 100% efficient, ie.; no bypass flow. 

• The pipes should always be designed for the worst case Schedule A pipe, that is a 
Manning’s value of n=0.013. 

• For the entrance loss coefficient, assume a square edge with Headwall. 

 
Figure 1 – PLAN VIEW 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 2 - CROSS SECTION 

 
 
 
 

 
 
 

Figure 3- PROFILE 
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Use the following data when creating nodes and reaches: 
 
 
 
 
 
 
 
 
 
 

 

Design Criteria for Storm Drains 
Chapter 6 of the Hydraulics Manual contains the design requirements for storm drain design.  In 
summary they are: 

• Velocity should be between 3 and 10 ft/sec in full condition. 

• Inlet structures should be no more than 300 feet apart.  (Designers should verify this with 
Region Maintenance). 

• Align the crowns (the internal high point) of pipes that are entering and leaving a 
junction. 

• The minimum pipe diameter is usually 12”. 

• Pipe slopes should be between 0.5% and 5%. 

Determine Project Configuration 
1) Create a New Project called network. 

 

Catch 
Basin 

Outlet 
Inv 
El. 

Rim 
El. 

CB1 332.5 337.0 

CB2 332.0 337.0 

CB3 330.0 336.0 

CB4 330.5 336.0 

CB5 334.8 338.5 

CB6 334.5 338.5 

Dummy 325.0 330.0 

Pipe Length Upstream 
Inv. 

Slope 

P-001 36 332.5 1.39% 

P-002 298 332.0 0.67% 

P-003 36 330.5 1.39% 

P-004 298 334.5 1.51% 

P-005 36 334.8 0.83% 

P-006 15 330.0 33.33% 
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2) The first step in any project is to customize defaults in the Project Configuration.  In this 
case we are going to modify the Default Labels to something that would be more 
meaningful for our project including:  

• Change the Padding to ‘0’ for the Reaches, Nodes, and Basins. 

• Change the prefix for Nodes to CB and delete the hyphen after Basins and Reaches.  

• The Default Labels tab should look as shown below: 

 
3) Next select the Project Defaults tab.  For this project we will use the precipitation values 

calculated in ‘Basin and Design Storm’ Tutorial, all other default values will remain.  
After modifying the precipitation values, the ‘Project Defaults’ tab should look as shown 
below.   
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Basin Calculations 
4) The next step is to perform the basin calculations, in other words determine how much 

runoff is going to each inlet.  That information will be used to create our basins in 3G.   

• Determine the area (in acres) that is contributing runoff to each inlet.  Be sure to include 
the runoff from the 5’ wide sidewalk. 
B1 = 25’ x 600’/43560sqft/acres = 0.344 acres 

• All the basins are the same size; however the length of flow to inlets CB4 and CB3 is 
only 300’, not 600’.  Since this will affect the time of concentration calculation, we will 
need 2 basins for this project; B1 and B2. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 3 – PLAN VIEW 
Hydraulic Report Tip – Basin calculations need to be verified by someone other than the 
designer.  To expedite the review process, designers should provide basin calculations and plan 
sheets that are both clearly labeled and to scale.  This label should match the name of the basin 
used in StormShed. 

Basin Definition 
5) Next we need to define the two drainage basins for our project.  Below is the drainage 

basin contributing to catch basins CB1/2/5/6. 

• Click on the New button and the default ‘B1’ should appear, select OK. 

• Change the rainfall type to Type 1A for WWA. 

• Use SBUH for the Design Method. 

• The Hyd Interval is 10 min for WWA.  

• And finally the Storm Duration is 24 hours for WWA. 
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6) Next go to the Perv CN and Perv TC tabs. 

For this example there are no Pervious surfaces, so delete the default values on these tabs.  
Next select the Directly Connected CN tab and input the basin data as shown below.  

 

 
 

7) Select the Directly Connected Tc tab to calculate the Time of Concentration for the 
basin. 

 
• For the flow type select ‘Sheet’ from the pull-down menu. 

• The description is automatically determined when the Coefficient is selected from the 
pull-down menu.  Find and LMB click on ‘Smooth Surfaces’ in the pull-down menu. 

• Type 20’ for the length (note the 5’ for the sidewalk was not included, this is because we 
are only concerned with the longest flow path). 

• Input 2% for the slope and hit the Add button to add this record. 
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• Repeat the steps for Shallow flow and input the values shown above. 
Notice the Total Tc (min) next to the gray box indicates our Tc is 5.30 min. for this basin. 

• Select the Close button when the record for B1 is complete. 
 

8) Now we will repeat the process for basin B2, which is contributing flow to CB3/4.  In 
this case we only need to modify the length of shallow flow.   

• The easiest way is to open basin B1 and then select the New button.   

• Select the default basin name of B2 and hit OK.  

 

 
Select the Directly Connected Tc tab. 

• Highlight the Shallow flow type by clicking on the LMB. 

• Double LMB click on the 600’ length and retype 300’. 

• Click on the Update button and the record should appear as shown above. 
Note the Total Tc (min) is now only 5 minutes, however the sum of the TT (travel time) is less 
than 5 minutes.  In this case the basin has used the default of 5 minutes minimum for travel 
time in a basin that was set up in the Project Configuration menu. 

9) Creating A New Layout 
Next we will create a new layout. 
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• To create a new Layout, click on the Layout View Tab and select the ‘Insert Nodes and 
Reaches’ radio button in the upper left corner.  

• Input the name ‘network’ for this example and select OK. 
  

10) Insert Nodes and Reaches 
Next we will input the network.  This will be a schematic view and not to scale; however, 
it is important that the angles between the pipes be accurately represented since 
StormSHED will use these angles to calculate headloss of flow through the system. 

 
When nodes and reaches are input into the layout view, it is important that they be 
entered from the most upstream node to the downstream node.  The direction the nodes 
and reaches are input establishes the direction of flow within 3G, as shown with the flow 
arrows below.  In order to input our layout with the correct flow direction, we will have 
to input our network in three steps. 

 
 Step 1 Step 2 Step 3 

• Toggle the ‘insert nodes and reaches’ button on and use the LMB to select the 
approximate location of the 4 nodes in Step 1.  Notice the reaches are automatically input 
between the nodes.  Toggle off the insert button after the 4th node has been input. 

• For Step 2 we can only add one node and one reach.  Toggle back on the ‘insert nodes 
and reaches’ button and using the LMB locate the node and reach in the approximate 
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locations as shown in Step 2.  Notice once the pink node is selected, the insert button is 
automatically toggled off. 

• Complete the network by toggling on the radio button and inputting the network as 
shown in Step 3.  Again the insert button will automatically toggle off once the pink node 
is selected. 
Note every structure entered is labeled ‘PROTOTYPE’.  Verify the flow direction is as 
designed by toggling on the ‘Draw Flow Direction Arrow’ radio button on the top of the 
layout view.  (The button immediately to the left can be used to fill the arrow head).   

 
If the arrow heads are not going in the direction expected, RMB click on the reach and 
select ‘Reverse Rch Direction’.  StormShed 3G will automatically reverse the flow 
direction and the arrowhead.  The process is the same to delete a node or reach only 
select ‘Delete’ from the menu.  Sometimes after the layout has been modified or an 
existing file has been opened, it is necessary to use the ‘Refresh View’ button to clean up 
the layout.   

 
If the view is too large or small, toggle on the ‘Zoom In’ or ‘Zoom Out’ button 

 
At the lower left corner of the layout, shows the zoom level.  A zoom level of 1.5 is 
shown below.  Also, to the right of the zoom level the name of the layout is shown as 
‘network’. 

 
Define Nodes and Reaches 
First we will create the nodes and reaches, and then we will define them in the Layout 
View. 
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11) Node Definition 
We will use the structure information from the first page of this tutorial to create our 
nodes.   

• Start by double LMB clicking on the Prototype node in the Tree View, the following 
box should appear. 

 
• Click on the new node button and accept the default name of CB1. 

• For the description type catch basin.   

• For Start and Max El. input the values from the table on the first page of this tutorial; 
332.5 and 337. 

• Select the Node Type radio button for MH/CB type.  (In other tutorials we will discuss 
most of the other Node Types in more detail). 
Next select the Contrib Drainage Area tab.  All the basins created in this project will 
appear.   

• Select B1 by using a single LMB click.  (If you go back to the CB1 tab, note the 
Contributing Basin box will show B1 in gray). 

 
Finally select the MH/CB Structures tab, this is where we will define the structure. 
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• From the Struct Type pulldown menu, select CB-Type 1.  Notice the Structure Bottom 

Area (sf) is linked to the Structure Type, in this case it is 3.97. 

• Make sure the Condition and Channelization boxes are not checked.  The Condition 
boxes should only be checked if this is an existing structure or a drywell.  The 
Channelization should be selected when the flow line runs along the bottom of the 
structure without a drop as shown in our example. 
Continue creating nodes using the table on the first page of this tutorial.   

12) Directions for the last node (DUMMY) on the table are shown below: 

 
• Select New Node and input DUMMY, hit OK. 

• For the description, type End of Pipe. 

• Use the Start EL(ft) and Max EL(ft) in the table on page 1 of this tutorial, 325 and 330. 

• Select OK to accept the Node. 
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13) Reach Definition 
Define the pipes using the Reach Definition from the first page of this tutorial; begin with 
the minimum allowed pipe diameter (12”).  When StormSHED 3G routes flow through 
the pipe it will determine if a larger pipe is necessary.  Double LMB click on the 
Prototype Reach in the Data Tree View and the following dialog box will open. 

 
• Select New and accept the default of P1. 

• For the Section Shape, select the Circular radio button. 

• Routing Method, Travel Time Shift, most common (uses the Manning’s equation) 
computing the velocity from the top to the bottom of each reach.  Muskingum-Cunge 
would be the only other one we would use for very long pipes. 

• Manning’s is the most commonly used in the US and the one we will be using. 
The Constraints tab only applies to underground conduit.  Setting these values will do 
two things: tell the program to a flag a value that falls outside the constraints after 
computing and when 3G sizes the system it will stay within the constraints.  We will 
show both in more detail later in this tutorial.  Input the values shown in the 
Constraints tab below, these are the constraints from the design criteria listed on the 2nd 
page of this tutorial.  Remember if these values are saved in the PROTOTYPE Reach, 
they will be carried over to all reaches created from the PROTOTYPE and will not have 
to be retyped each time a reach is created. 
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The besides the design criteria given at the beginning of this tutorial, Constraints 
affecting up and down inverts, are briefly described below: 

• Min Cover – Chapter 8 of the Hydraulics Manual requires 2’ of cover from the bottom of 
pavement to the top of the pipe.  Determining this value will take some time.  Designers 
will need to determine: the pavement thickness, and wall thickness of the pipe.  These 
values should be added to the 2’ depth and that value should be input here.  If 2’ of depth 
can not be met, designers should review the shallow cover requirements in Chapter 8 of 
the Hydraulics Manual. 

• Drop across MH – this only applies to manholes.  The drop refers to the distance between 
inverts in elevation entering and leaving a node.  Checking this option, would do two 
things: the program would flag a greater elevation that is manually entered after using the 
compute command or if the program synchronized the inverts or computed 
diameters/slopes it would use this constraint in the design. 
Exfiltration/Infiltration was explained in the ditch tutorial leave this value at 0 for this 
example.   
The ‘Transition constraints across node’ applies only when 3G is going to calculate the 
pipe diameters/slopes or the synchronize invert option is used.  We will try this later in 
our tutorial but for now leave the boxes blank. 

• Hold Up/Dn IE – this option will hold the up or down invert elevation when using the 
synchronize invert option. 

• Match Inverts – if this box is not checked, the program will align the crowns when the 
synchronize invert option is used. 

• Allow Smaller Conduits – when 3G sizes  
14) The Geometry tab options vary based on what was selected in the Section Shape on the 

first tab.  For example, the gray boxes are only available when the ditch or x-section 
option is selected. 
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• Use the Size pull down menu to select 12 in diam.  This is our first guess for the pipe 

size, we will find out after running the design storm through the network if this size will 
work.  This method for sizing pipe is considered the trial and error approach, as pipe sizes 
are modified based on the output. From 3G. 

• Entrance Losses – the pull-down menu provides a list of different entrance losses that 
would best describe the shape of the pipe exiting the node.  For most nodes, including 
this example, Circular Conc: Square Edge w/Headwall is the best description. 
For Specific Geometry the length, slope and elevation of the pipe will be set.   

• For Length input 36 ft. 

• The slope should be 1.39%, this will have to be set twice because the slope is calculated 
from the up and down IE or invert elevation. 

• Set the Up IE at 332.5 ft and the Dn IE at 332.  At this point the slope will have to 
modified again to 1.39%. 

15) Continue to create reaches, using the information provided in the tables on the first page 
of this tutorial.   

16) Define Reaches and Nodes in Layout View 
Now we need to show StormSHED the location of each node and reach.   

• In the layout view double click on the upper left hand node and the node dialog box will 
open. 

• Using the pull down menu Node ID, select CB1.  

• Select Okay to close the dialog box. 

• Repeat this process until all the nodes and reaches are defined. 
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The network should appear as shown below when you are finished. 

 
17) Now the network is completely entered and ready for analysis.  Using the LMB, select 

the compute button in the layout toolbar. 

 
 
The following box should open.  This is where we will define the network we are 
analyzing, as well as the storm that should be used to size the system. 

• Select network from the pull down menu in the through: box. 

• The 25 year Design Event is used to design conveyance systems. 

• The Rainfall Type for WWA Type 1A storm.   The Storm Duration for WWA it is 24 
hours.   

• For this example, only the Automatic HGL should be checked.   

• Select the Route button and then Close. 
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18) First look at the Layout View for any red numbers or brackets. This would indicate the 

design is outside of the constraints. 
19) Next select the History View tab.  Go through the data and make sure all the design 

criteria parameters are met.  Also, the outlet velocity should be compared to the velocities 
in section 3-4.7 of the Hydraulics Manual to determine if an energy dissipater is needed 
for outlet protection. In this case the outlet velocity from P6 (16.38 ft/sec) is high enough 
to warrant heavy loose riprap or a concrete splash pad for outlet protection.  Designers to 
review section 3-4.7 of the Hydraulics Manual for the design criteria of Energy 
Dissipaters. 

Outlet Velocity 

(ft/sec) 

Material 

6-10 Quarry Spalls 

10-15 Light Loose Riprap 

>15 Heavy Loose Riprap 
Designers should provide geotextile or filter material 
between any outlet material and the existing ground 
for soil stabilization, see section 4-6.3.2 for 
information.. 

Outlet Protection Material Size 
Figure 3-4.7.1 

20) Creating a Report 
Remember only the last record sent to the History View is retained, so once the final 
compute has been run copy the output and paste it into a word processing program.  The 
history view should appear as shown below. 
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Appended on: Sunday, May 7, 2017 5:25:40 PM 

ROUTEHYD [] THRU [network] USING [25 year] AND [TYPE1A.RAC] 
NOTZERO RELATIVE SCS/SBUH 

Gravity Analysis using 24 hr duration storm 

Reach 
ID 

Area 
(ac) 

Flow 
(cfs) 

Full Q 
(cfs) 

Full 
ratio 

nDepth 
(ft) 

Depth 
ratio Size nVel 

(ft/s) 
fVel 
(ft/s) 

Infil 
Vol 
(cf) 

CBasin 
/ Hyd 

P5 0.344 0.3156 3.2546 0.097 0.2104 0.2104 12 in 
Diam 2.6254 4.1439 0.00 B1 

P4 0.688 0.6313 4.3898 0.1438 0.2557 0.2557 12 in 
Diam 3.982 5.5893 0.00 B1 

P3 0.344 0.3157 4.2118 0.0749 0.185 0.185 12 in 
Diam 3.1558 5.3626 0.00 B2 

P1 0.344 0.3156 4.2118 0.0749 0.185 0.185 12 in 
Diam 3.1557 5.3626 0.00 B1 

P2 0.688 0.6313 2.9241 0.2159 0.3157 0.3157 12 in 
Diam 2.9682 3.7231 0.00 B1 

P6 2.064 1.8939 20.6242 0.0918 0.2047 0.2047 12 in 
Diam 16.3808 26.2595 0.00 B2 

HGL Analysis 
From 
Node 

To 
Node 

HG El 
(ft) 

App 
(ft) 

Bend 
(ft) 

Junct Loss 
(ft) 

Adjusted HG El 
(ft) 

Max El 
(ft) 

 325.5868 
CB3 Dummy 330.7198 ------ 0.2998 0.1738 331.1934 336.0000 
CB6 CB3 334.9499 ------ 0.1349 ------ 335.0848 338.5000 
CB5 CB6 335.2278 ------ ------ ------ 335.2278 338.5000 
CB4 CB3 331.1996 ------ ------ ------ 331.1996 336.0000 
CB2 CB3 332.4541 ------ 0.2089 ------ 332.6630 337.0000 
CB1 CB2 332.8077 ------ ------ ------ 332.8077 337.0000 

Conduit Notes 

Reach HW Depth 
(ft) 

HW/D 
ratio 

Q 
(cfs) 

TW Depth 
(ft) Dc (ft) Dn 

(ft) Comment 

P6 0.7198 0.7198 1.89 0.5868 0.5868 0.2047 SuperCrit flow, Inlet end 
controls 

P4 0.4499 0.4499 0.63 1.1934 0.3308 0.2557 SuperCrit flow, Inlet end 
controls 

P5 0.4278 0.4278 0.32 0.5848 0.2315 0.2104 Outlet Control M1 
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Backwater 
P3 1.2000 1.2000 0.32 1.1934 0.2315 0.1850 Outlet Control 

P2 0.4541 0.4541 0.63 1.1935 0.3308 0.3157 SuperCrit flow, Inlet end 
controls 

P1 0.3077 0.3077 0.32 0.6630 0.2315 0.1850 SuperCrit flow, Inlet end 
controls 

 
 

Licensed to: WS DOT 
 

21) To make your hydraulic report complete, you will also need to include the basin, reach 
and node information and a picture of the layout.  This information will need to be sent to 
the History View and copied into a word processing document.   

 
• In the Data Tree View click on the name of the layout (network) with the LMB. 

• Select To History and all the records in that layout will be sent to the History View. 

 
Appended on: Sunday, May 7, 2017 5:26:38 PM 

Layout Report: network 
Event Precip (in) 

other 2.10 
2 yr 24 hr 2.50 
10 year 3.00 
5 year 3.50 
25 year 4.00 
100 year 4.50 

Reach Records 

Record Id: P1 
Section Shape: Circular 
Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
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DnNode CB2 UpNode CB1 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 36.00 ft Slope 1.39% 
Up Invert 332.50 ft Dn Invert 332.00 ft 

Conduit Constraints 
Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Record Id: P2 
Section Shape: Circular 
Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
DnNode CB3 UpNode CB2 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 298.00 ft Slope 0.67% 
Up Invert 332.00 ft Dn Invert 329.9999 ft 

Conduit Constraints 
Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Record Id: P3 
Section Shape: Circular 
Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
DnNode CB3 UpNode CB4 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 36.00 ft Slope 1.39% 
Up Invert 330.50 ft Dn Invert 330.00 ft 

Conduit Constraints 
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Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Record Id: P4 
Section Shape: Circular 
Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
DnNode CB3 UpNode CB6 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 298.00 ft Slope 1.51% 
Up Invert 334.50 ft Dn Invert 330.00 ft 

Conduit Constraints 
Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Record Id: P5 
Section Shape: Circular 
Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
DnNode CB6 UpNode CB5 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 36.00 ft Slope 0.83% 
Up Invert 334.80 ft Dn Invert 334.50 ft 

Conduit Constraints 
Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Record Id: P6 
Section Shape: Circular 
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Uniform Flow Method: Manning's Coefficient: 0.013 
Routing Method: Travel Time Shift Contributing Hyd  
DnNode Dummy UpNode CB3 
Material unspecified Size 12 in Diam 
Ent Losses Square Edge w/Headwall 
Length 15.00 ft Slope 33.33% 
Up Invert 330.00 ft Dn Invert 325.00 ft 

Conduit Constraints 
Min Vel Max Vel Min Slope Max Slope Min Cover 
3.00 ft/s 10.00 ft/s 0.50% 5.00% 2.50 ft 

 

Drop across MH 0.00 ft Ex/Infil Rate 0.00 in/hr 
 

Node Records 

Record Id: CB1 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 332.50 ft Max El. 337.00 ft 
Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
 

Record Id: CB2 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 332.00 ft Max El. 337.00 ft 
Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
 

Record Id: CB3 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 330.00 ft Max El. 336.00 ft 
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Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
 

Record Id: CB4 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 330.50 ft Max El. 336.00 ft 
Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
 

Record Id: CB5 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 334.80 ft Max El. 338.50 ft 
Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
 

Record Id: CB6 
Descrip: Prototype Record Increment 0.10 ft 
Start El. 334.50 ft Max El. 338.50 ft 
Void Ratio 100.00    
Condition Existing Structure Type CB-TYPE 1  

  Channelization No Special Shape  
Catch 0.00 ft Bottom Area 3.97 sf  
MH/CB Type Node  
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Record Id: Dummy 
Descrip: DUMMY Increment 0.10 ft 

Start El. 325.00 ft Max El. 330.00 
ft 

Void Ratio 100.00    
Dummy Type Node  
 

Contributing Drainage Areas 

Record Id: B1 
Design Method SCS Rainfall type TYPE1A.RAC 
Hyd Intv 10.00 min Peaking Factor 484.00 
Storm Duration 24.00 hrs Abstraction Coeff 0.20 
Pervious Area 0.00 ac DCIA 0.344 ac 
Pervious CN  0.00 DC CN  98.00 
Pervious TC 0.00 min DC TC 5.2975 min 

DCI - CN Calc 
Description SubArea Sub cn 

cb area 0.344 ac 98.00 
DC Composited CN (AMC 2) 98.00 

 

DCI - TC Calc 
Type Description Length Slope Coeff Misc TT 

Sheet Smooth Surfaces. 20.00 ft 2.0% 0.011 0.00 in 0.3783 min 
Shallow Paved 600.00 ft 1.0% 0.01  4.9193 min 

Pervious TC 5.2975 min 
 

 

Record Id: B2 
Design Method SCS Rainfall type TYPE1A.RAC 
Hyd Intv 10.00 min Peaking Factor 484.00 
Storm Duration 24.00 hrs Abstraction Coeff 0.20 
Pervious Area 0.00 ac DCIA 0.344 ac 
Pervious CN  0.00 DC CN  98.00 
Pervious TC 0.00 min DC TC 5.00 min 

DCI - CN Calc 
Description SubArea Sub cn 
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cb area 0.344 ac 98.00 
DC Composited CN (AMC 2) 98.00 

 

DCI - TC Calc 
Type Description Length Slope Coeff Misc TT 

Sheet Smooth Surfaces. 20.00 ft 2.0% 0.011 0.00 in 0.3783 min 
Shallow Paved 300.00 ft 1.0% 0.01  2.4596 min 

Pervious TC 2.8379 min 
 

 
 

 
Licensed to: WS DOT 

22) Print Layout 
Last we will print a copy of the layout we created.   

 
• First use the ‘Toggle Node Label’ and ‘Toggle Reach Label’ buttons until the node and 

reach names are shown on the next page. 

• Then click on the ‘Select Area for Clipboard’ radio button. 

• LMB click in the upper left portion of the layout and drag a window around the layout. 
Release the LMB to accept the 2nd point. 

• Open the word processing program you are using and use the ‘Paste’ (or Ctrl V) 
command to insert the layout.  It should appear as shown in the following figure. 
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23) Other Options for Pipe Sizing 
There are 2 other options for sizing pipe; the first involves using the Calculator located 
at: 

Misc>Calculator 
When the calculator shown below opens, select the Pipe Calc tab. 

• Leave the Select Reach box empty (or a reach that has already been created can be 
selected from the pull down menu). 

• Input the values shown in the diameter, Manning’s n, Slope, and Flow (use the flow from 
the basin compute option with the 25 year) boxes shown below.  The gray boxes are 
automatically calculated based on the values input.  Review the data to determine what 
pipe size is required, for this example a 12 in diameter pipe will work. 
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24) Zero Slopes/Diameters 
Another option is to allow 3G to compute the diameters and slopes. 

• After the network is complete, select the ‘Zero Slopes/Diams’ button.  This will set all the 
reach diameters and slopes to zero.  (If you are planning to have 3G set the diameters and 
slopes, set them to zero when creating the reaches). 

 
• Select ‘Clear Slopes’ and ‘Clear Diameters’ by LMB clicking in the boxes. 

• Highlight the Reaches shown by holding down and dragging the LMB over the reaches. 

• Hit the Clear button and the box will automatically close. 

 
• Open reach P6 and go to the Constraints tab.  Check the Hold Dn IE box.  This will hold 

the elevation for the pipe outlet that we set earlier. 

 
 

• In the Layout View, select the Compute button.  Select the Route button to size the pipes 
and slopes.  Toggle through the Reach labels to see what the new diameters and slopes. 

 


	01_Stormshed3G_Introduction
	02_WorkSession1_Stormshed3G_Beg_Overview_and_Project_Config_2017
	03_WorkSession2_Stormshed3G_Beg_Basin_and_Conveyance_Design_Storms_2017
	Example Problem
	Figure 1
	Figure 2
	Creating a New File
	4) WWA – Storm Duration
	Create Basins


	04_WorkSession3_Stormshed3G_Beg_Ditch_Design_2017
	Figure 4-2 Cross Section
	Creating a New File
	Appended on: Sunday, May 7, 2017 3:28:33 PM
	ROUTEHYD [] THRU [Ditch] USING [10 year] AND [TYPE1A.RAC] NOTZERO RELATIVE SCS/SBUH
	Gravity Analysis using 24 hr duration storm
	HGL Analysis
	Conduit Notes
	Node and Reach invert report

	Appended on: Sunday, May 7, 2017 3:38:33 PM
	ROUTEHYD [] THRU [Ditch] USING [10 year] AND [TYPE1A.RAC] NOTZERO RELATIVE SCS/SBUH
	Gravity Analysis using 24 hr duration storm
	HGL Analysis
	Conduit Notes
	Node and Reach invert report


	05_WorkSession4_Stormshed3G_Beg_PipeNetwork_Design_2017
	Figure 1 – PLAN VIEW
	Figure 2 - CROSS SECTION
	Figure 3 – PLAN VIEW
	ROUTEHYD [] THRU [network] USING [25 year] AND [TYPE1A.RAC] NOTZERO RELATIVE SCS/SBUH
	Gravity Analysis using 24 hr duration storm
	HGL Analysis
	Conduit Notes


	Layout Report: network
	Reach Records
	Record Id: P1
	Record Id: P2
	Record Id: P3
	Record Id: P4
	Record Id: P5
	Record Id: P6

	Node Records
	Record Id: CB1
	Record Id: CB2
	Record Id: CB3
	Record Id: CB4
	Record Id: CB5
	Record Id: CB6
	Record Id: Dummy

	Contributing Drainage Areas
	Record Id: B1
	Record Id: B2




